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This is a comprehensive guide for absolute beginners looking to get started in painting. In writing this, I considered what I would do if I had to go back and learn painting all over again. I have broken the guide into 7 simple steps you can follow: John Singer Sargent, Simplon. Pass, 1911 Before you go out and buy all your new art supplies and start
throwing paint onto the canvas, you should consider why exactly you want to take up painting and what you want to get out of it. Your answers will determine how you proceed and what you should focus on learning. I don’t believe that there is a static learning path that everyone must follow to master painting. Everyone has different tendencies,
interests, and natural skills, which determine the optimal learning path they should take. For example, some people do not have the patience to sit down and accurately render every tone and detail of a subject. Therefore, they may be better suited to learn color and brushwork from the Impressionists rather than the rigorous practices of the Russian
academic painters. Or maybe you have no interest in breaking into the commercial art world and just want a fulfilling hobby. In that case, you may want to take a more relaxed approach to how you learn. Or maybe you want to become a master realist painter like John Singer Sargent or Joaquin Sorolla. To get anywhere near this goal, you would need
to follow a dedicated and rigorous training regime that focuses on drawing and the other fundamentals of painting (color, value, composition, etc). Joaquin Sorolla, Sewing the Sail, 1896 Whatever the case, it is important that you have self-awareness of why you are doing this in the first place and what you want to get out of it. If you have not already,
take a second to think about it. You may even want to share your answer in the comment section at the end of this post. Next, you should decide on a medium to focus on, at least for the short term. This will allow you to really get a feel for how the medium works, so that you can then pay more attention to the big-picture aspects of painting, like color,
composition, value, etc. The major choices are oils, acrylics, and watercolors. There are some other options, like gouache and water-mixable oils, but I won’t touch on these in this guide. But there is no right or wrong answer here. Every medium has pros and cons. Here is a crash course on the different mediums to help you decide which suits you:
Acrylics are widely favored by those just starting out with painting as they are easy to use and do not require any special supplies. The downside is they dry very fast. Acrylics may suit you if: You are a complete beginner and do not want to worry about the complexities of oil and watercolor painting. You want an easy cleanup time. You are painting on
a limited budget. You enjoy experimenting with mixed media. You are sensitive to the harsh chemicals involved with oil painting. The downsides of acrylics are: The paint dries very fast. This means you only have a limited amount of time whilst your paint is responsive on the canvas. Some colors darken as they dry (the colors that are lighter tend to
have a greater change). I personally started with acrylics many years ago. Below is one of my childhood paintings in acrylics. I eventually moved to oils after getting frustrated by the quick drying time of the paints. But acrylics were great for developing a broad understanding of painting whilst I was a beginner. Dan Scott, Early Painting - Mountain
Reflection Oil paints are the most widely used medium among professional artists for a number of reasons: They are versatile. You can vary the drying time and consistency of your paint dramatically using paint thinners and additional oil. This allows you to work with a wide range of painting techniques, including blending, glazing, and scumbling.
They were favored by the all-time greats of painting. Oil paintings seem to be held in higher regard by art collectors compared to acrylic paintings (there are of course some exceptions to this). You really cannot go wrong with oil paints. If you are not sure where to start, I suggest either jumping straight into oils or starting with acrylics with a view of
jumping over to oils once you are more developed. There are some fantastic acrylic painters, but many of them paint in a very contemporary style. The traditional painting techniques which were used by the old masters are much better suited to oil painting. If you think oil painting is too complex for you, then I urge you to reconsider. There are really
only a few ‘rules’ that you need to understand in oil painting and the rest is very similar to acrylic painting. Tip: For those of you who are concerned about the harsh solvents used in oil painting, like turpentine, then check out odorless solvent. It makes oil painting much more pleasant. You could also look into water-based oils. Dan Scott, Secrets on
the Lake, 2017 Watercolors are generally considered to be the most difficult to pick up due to the untamed nature of water and the fact you are not able to do much re-working of errors (as the paper can only absorb so much water). However, if mastered, watercolors can produce stunningly elegant paintings. For this reason, I recommend you start
out with either acrylics or oils before venturing into watercolors. However, watercolors are a fantastic complement to your acrylic or oil painting as they train a different skill set. For example, John Singer Sargent was famous for his meticulous portraits using oils, but he used watercolors to paint impressionist and relaxed landscapes and portraits.
These watercolor paintings probably felt very refreshing for Sargent, who would have been accustomed to the lengthy and tedious portrait painting sessions. John Singer Sargent, Carrara, Working, 1911 (If you want to learn more about master artists like Sargent, make sure to join my free Exploring the Masters series.) There is no right answer here,
but if you are just starting out in painting, then I recommend you start with acrylics or oils. But feel free to start with watercolors if you are up for the challenge. Also, this is not to say you must choose a medium and ignore the rest. I encourage you to try many different mediums but have one which you really focus on and get familiar with. It is better
to be a master of one medium than be average at all mediums. It’s time to stock up on art supplies. But make sure you read all of this section first before you start buying every type of brush or every color of paint - you do not actually need that much stuff! The supplies you get will vary depending on the medium you decide to go with. In a broad
sense, all you need is: An easel to hold your artwork; Canvas (for acrylic or oil painters) or paper (for watercolor painters); A palette for color mixing; Brushes (suitable for your chosen medium); Palette knives; Paints; Solvent (if oil painting); and Paper towels (for wiping your brush between strokes). That's it, really. Painting can be as simple as you
want to make it. You will be able to find all this at your local art store. If you are an absolute beginner, it may be worth starting with a beginner package that includes most of the basic supplies you would need. You can then upgrade later on. My main suggestion is to keep it simple and purchase quality where it matters, like your brushes, canvas, and
paint (a premium quality easel will not make you a better painter). As Richard Schmid wrote in his book Alla Prima: “If Michelangelo had possessed only a broom and a bucket of mud, he could still have painted the Sistine Chapel ceiling, and it would have been just as much of a masterpiece!” As for the colors, I suggest you start with a limited palette
that has red, blue, yellow (the primary colors), white, and an earth tone like raw umber. Here is a good starter palette: Cadmium red Ultramarine blue Cadmium yellow Titanium white Raw umber I am a big believer in learning efficiently rather than just putting in time for the sake of it. You could practice for years and hardly improve if you don’t
know what you are doing. This is where the fundamentals of art come into play - color, value, composition, edges, brushwork and technique. These are what I consider to be the core pillars of painting. It is important that you get familiar with them early, as they will help you understand what exactly is going on when your brush hits the canvas.
Learning these fundamental areas will benefit every stroke you make. Here is a summary of the fundamentals: Color: We are all familiar with color, so much so that we take it for granted. Few people fully understand and appreciate what color actually is. I find it easier to comprehend color in terms of hue, saturation, and value. These are the three
elements that make up a color. Hue refers to where a color is located on the color wheel. Red, blue, yellow, green—these are all different hues. Saturation refers to how rich, intense, or vibrant a color is. Value refers to how light or dark a color is. Learn these three terms and learn them well, as you will encounter them with every artwork you create.
Childe Hassam, The Aquarium with Gold Fish, 1912 Value: Value is an element of color, but it is generally considered as a separate fundamental area due to its importance to painting. Every color has an underlying value somewhere between white and black. For example, take the following painting by Claude Monet. Claude Monet, Fishing Boats,
1886 If I take color out of the equation, we are left with nothing but the different values ranging from light gray to almost black. This painting has a strong value structure, as you can clearly make sense of it without color. A strong value structure is not essential by any means (just look at many of the great Impressionist paintings) but it certainly
helps in giving your painting a solid foundation. If you paint with accurate values, then you have more leeway with your use of brushwork, color, and detail. Composition: You will hear all kinds of complex terms, “rules” and theories used to explain composition in painting. Things like... Focal point Rule of thirds Golden mean Horizon line Leading lines
Harmony Rhythm Movement Balance .... and so on. But really, there are only two questions that are important for creating great compositions. What do you want to say? How are you going to say it? That is it. None of the other stuff matters all that much. Let’s dive into those questions a bit deeper...What do you want to say? In other words, if your
painting could speak, what would it say? If you don’t know, then you are working blind. Also, this does not need to be some deep and philosophical statement. It could be as simple as.... “I want to capture the way light is bouncing off the river surface.” But it is important that you know what you want to say - a big idea you want to communicate. How
are you going to say it? Or, how are you going to arrange all the elements in your painting to work in harmony and communicate what you want to say? Think of all your individual strokes, shapes, lines, colors, and textures as tools at your disposal. Claude Monet, Etretat the Aval Door Fishing Boats Leaving the Harbour, 1885 Edges: An edge is what
separates two shapes. It can be either hard, soft, or lost. Hard edges have a clean transition between the two shapes; soft edges have a smooth transition; and lost edges are so smooth you can barely see them. Dan Scott, Three Boats at Kingfisher Bay, 2016 Brushwork: The physical marks left by your brush (or your palette knife, finger, or anything
else you use to paint with). This is an overlooked aspect of painting, which is odd because it is what makes a painting look like a painting. If not for brushwork, we may as well just take a photograph or practice digital art rather than traditional art. Dan Scott, Honeymoon Bay, Tasmania, 2019 - Close-Up Technique: How well you are able to perform
certain actions. Good technique will develop over time as you gain experience and become more comfortable with your brush and paints. But you need to be careful of any bad habits which you may pick up along the way. This could be the way you hold your brush or the types of strokes you make. Bad habits can be incredibly difficult to fix after you
have been practicing them for a number of years. To develop good painting technique, I suggest you carefully watch master artists paint. Observe how they hold their brush, how they apply paint to canvas, how they mix colors, and so on. One of the most challenging aspects of painting happens before you pick up your brush - selecting a subject to
paint. The perfect subject should be inspiring and challenging. You should feel the need to paint it. Here are some questions to help you determine if a subject is worth painting: Is there a “big why”? A single idea that makes you want to paint it. Is there a clear and identifiable color harmony? Does the subject have an interesting design (think about
the arrangement of shapes, forms, lines, and colors)? Is there anything you can do to improve on the subject? Are you capable of painting it? Do you have the supplies required to paint it? What problems will you encounter painting it? Does the subject provide you with opportunities to challenge yourself and demonstrate your abilities? Does the
subject inspire you? Can you see a finished painting at the end of it all? If so, do you like what you see? Ask yourself these questions next time you are not sure if a subject is worth painting. Note: These questions are not necessarily there to be answered but rather to make you question and explore the subject before you commit to something more. As
an example, the following photo is something I would like to paint. Here is why: I love the contrast between the light greens getting hit by light and the foreground in shadow. This is what I would focus on capturing if I were to paint it - my big idea. The composition is interesting. There is a pleasing balance between active and quiet places. I can see
myself painting this. (Additional reading: 7 Tips for Overcoming Artist Block) You are now ready to create your first painting. Just a word of warning though, it will be harder than it looks! The master artists make it look effortless, but don’t forget they have been painting for many years, even decades in some cases. My main suggestion for your first
painting is to start general; try to capture your initial impression of the subject. Think about the subject in terms of shapes and colors. You can then refine the painting and add more detail. As an example, I will run you through one of my paintings. Below is the reference photo I painted from. I started by loosely painting in the major colors and shapes
with a light wash. I then started to build up the form and structure. The finished painting is below. This should give you an idea of how rough and general I start a painting. Of course, some subjects require more delicate attention, but that is something you need to consider on a case-by-case basis. Dan Scott, Sunset Study, Kingfisher Bay, 2017 You
can see more step-by-step paintings on the video page. Here is an example of a simple landscape painting: You might also find this video helpful: How I Painted Magenta Flowers. Tip: Be proud of your first artworks, even if they do not turn out as planned. One day, you will look back and see how far you have come. Below is one of my early paintings
from when I was a child. Not perfect by any means (I even forgot to paint the right side of the ocean...) but it reminds me of how I started. Also, don’t compare your first few paintings to the works of other artists. Most people do not share their early or failed works; you only see their best. Dan Scott, Early Painting - Impressionist Wave Once you have
created your first painting, it is time to take a step back and review what went right, what went wrong, and where you can improve. Unless you are some kind of prodigy, your first painting probably won’t be a masterpiece but that is ok. Everyone starts as an amateur, even the masters. Look at your painting like an art critic. Here are some questions
to ask yourself: What aspects of the painting do I like? What aspects would I change? What is the mood of the painting? What is my first impression of the painting? I suggest you take a break from looking at the painting for a day or two, then come back to it. Do the colors work, or do they appear muddy? Is the composition pleasing? Is there any
visible brushwork that adds to the painting? Have I captured the overall likeness of the subject? Is there anything in particular that irritates me about the painting? Have I captured the perspective accurately? Does the painting appear cohesive? Fisherman in Valle d’Aosta, John Singer Sargent, 1907 Don’t worry about what other people think. Accept
criticism but do not let it be the main driver of what you do. Engage in the community. Enter competitions, visit galleries, talk to other artists, read artist blogs, subscribe to artist newsletters, etc. The more engaged you are, the more inspired you will be. Try not to be intimidated by artists who are more skilled. There will always be someone more
skilled, experienced, knowledgeable, or technical than you. Look to them for inspiration rather than be intimidated by them. Don’t worry that much about developing a memorable or unique style if you are just starting out. It will develop over time with experience. Focus on the fundamentals—color, value, composition, edges, brushwork, and
technique. These areas will benefit every stroke you make and will compound your level of improvement over time. Research the masters who came before us. Learn about how they lived, studied, and worked. This will provide you with a constant source of inspiration and knowledge. Don’t be afraid to experiment and try new things. Be careful of
gimmicky techniques, secrets, rules, or methods. Be open-minded and flexible with how you learn. The only secret to becoming a great painter is to learn, practice, review, and improve. Dan Scott, Honeymoon Bay, Tasmania, 2019 Here are some other helpful resources to help you on your painting journey: Painting Academy course: This will get you
up to speed on the fundamentals and make sure we are all on the same page. Exploring the Masters: A free email series that will introduce you to other master artists and paintings. Supply List: What I use and recommend. Artist Website Tutorial: Learn how to set up your artist website to showcase and document your work and progress. Painting
the Landscape Workshop: I'll walk you through the entire process using one of my paintings. You'll see how I go from idea all the way through to reflecting on the finished painting. This is a free 4-day workshop via email lessons. I appreciate you taking the time to read this post and I hope you found it helpful. Feel free to share it with friends. Happy
painting! Dan Scott Draw Paint Academy 1 Open Start . Click the Windows logo in the bottom-left corner of the screen. 2 Type in paint. This will search your computer for the Paint program. Advertisement 3 Look for the Paint app icon. In the Start menu, look for the Paint app icon, which resembles a paint palette with paint on it. 4 Click Paint. It's
next to the Paint app icon. Doing so will open a new Paint window.[1] Advertisement 1 Review the toolbar. The toolbar, which is at the top of the Paint window, is where you'll find all of the options used to interact with the Paint canvas. 2 Select a primary color. Click any color in the palette that's in the top-right side of the Paint window to apply it to
the "Color 1" box. This is the color that you'll use when using the left mouse button on the canvas. You can create a custom color by clicking Edit colors in the upper-right corner of the window, selecting a color and shade you want to use in the color wheel, and clicking OK. 3 Select a secondary color. Click the "Color 2" box to the left of the color
palette, then click the color you'd like to use as your secondary color. You'll activate this color by using the right mouse button on the canvas. 4 Select a brush type. Click the Brushes option at the top of the Paint window, then click the type of brush tip you want to use. This is what affects the line size, shape, and width options.[2] If you just want to
draw a regular free-form line, click the pencil-shaped "Pencil" icon in the "Tools" section. 5 Select a line thickness. Click the Size option to the left of the color palette, then click the line thickness you want to use while drawing. 6 Click and drag across the canvas to draw. Holding down the left mouse button while dragging will draw your line. You can
click and drag with the right mouse button to use your secondary color. 7 Fill a section with color. Click the "Fill with color" tool, which resembles a paint bucket, in the "Tools" section, then click the canvas to change an entire section of it to your primary color (you can right-click to use your secondary color instead).[3] If you have the canvas
sectioned off (e.g., a line dividing the canvas in two), only the section in which you click will be filled with color. If your canvas is blank or contains no full sections, your whole canvas will be filled in when you use the "Fill with color" tool. 8 Erase mistakes. You can use the eraser function by clicking the pink "Eraser"” icon in the "Tools" section and
then clicking and dragging the eraser over the portion of the image you want to erase. The eraser will use your secondary color, so you may have to reset the secondary color to white (or your drawing's background color, if different) before erasing. Advertisement 1 Select a color. Click the color you want to use as your shape's outline. 2 Select a "Fill"
color if necessary. If you want to fill the shape with a color rather than just drawing the outline of the shape, click the "Color 2" box and then click the color you want to use for the fill color. 3 Find a shape to use. In the "Shapes" section of the toolbar, scroll up or down to see all of the available shapes. 4 Select your preferred shape. Click the shape
you want to use to select it. 5 Select a line thickness. Click Size, then click the line thickness you want to use in the resulting drop-down menu. 6 Select an "Outline" option if needed. By default, the shape's outline will be the same color as the "Color 1" box; if you want to change the consistency of the color or remove it entirely, click the Outline drop-
down bogx, then click an option (e.g., No outline) to apply it. 7 Select a "Fill" option if you like. If you selected a "Fill" color, you can add the "Fill" option to your shape: click Fill, then click Solid color. You can select a different "Fill" option (e.g., Crayon) to use a stylized fill texture. 8 Click and drag diagonally across the canvas. This will draw your
shape. 9 Anchor the shape. Once the shape fits the size and location you had in mind, release the mouse button and click outside of the Paint canvas. Advertisement 1 Select a text color. Click the "Color 1" box, then click the color you want to use. 2 Click A. It's at the top of the window. 3 Select a location for your text. Find the place on your canvas in
which you want to place the text, then click the place in question. You should see a dotted line indicating a text box appear. 4 Change the text's font. In the "Font" section of the toolbar, click the top text box and then click the font you want to use in the resulting drop-down menu. 5 Change the font's size. Click the number below the font name, then
click the number you want to use for your font. 6 Add formatting to the text. If you want to bold, italicize, and/or underline your text, click the B, I, and/or U button(s) in the "Font" section of the toolbar. 7 Increase the text box's size if necessary. Since you adjusted the default font and size, you may need to enlarge the text box. You can do this by
placing your mouse cursor over one of the corners of the text box and then dragging diagonally away from the text box's center. 8 Enter your text. In the text box, type in the text that you want to display. 9 Give your text a background if you like. If you don't want your text to sit on whatever background items are on your canvas, click Opaque in the
"Background" section of the toolbar. Your text's background will be the secondary color listed in the "Color 2" box. 10 Anchor your text. When you're done editing your text, click anywhere on the canvas (or outside of it) to anchor the text. Once text has been anchored, you can't move it. Advertisement 1 Click File. It's in the top-left corner of the Paint
window. A menu will appear. 2 Click Open. This is in the middle of the menu. Doing so opens a File Explorer window. 3 Select a photo. Go to the file location of the photo that you want to open in Paint, then click the photo to select it. 4 Click Open. It's in the bottom-right corner of the window. Your photo will be uploaded to Paint, and your Paint
canvas should resize to fit the photo. 5 Use the right-click menu to open images in Paint. If you ever want to open an image in Paint when Paint isn't already open, you can right-click the image, select Open with in the drop-down menu, and click Paint in the resulting pop-out menu. Advertisement 1 Click Select. It's in the upper-left side of the Paint
toolbar. A drop-down menu will appear.[4] 2 Click Rectangular selection. This is in the drop-down menu.[5] If you want to draw the selection by hand, click Free-form selection here instead. 3 Create your selection. Click and drag diagonally from the top-left side of the area you want to save down to the bottom-right side, then release the mouse
button.[6] If you're using a free-form selection, click and drag around the item you want to crop, making sure to connect the two ends of the selection before proceeding. 4 Click Crop. It's at the top of the Paint window. Doing so will remove any part of the photo that's outside of the selected area, leaving only the area inside of the selection.[7] If you
want to cut your selected section out of the photo and leave the rest of the photo in, press the Del key instead. 5 Click Rotate. This option is at the top of the Paint window. A drop-down menu will appear. 6 Select a rotation option. Click one of the rotation options in the drop-down menu to apply it to the photo. For example, clicking Rotate right 902
would rotate the photo so that the right-most edge would become the bottom edge. Advertisement 1 Click Resize. It's in the Paint toolbar. A pop-up window will appear.[8] 2 Check the "Maintain aspect ratio" box. This option is in the middle of the window. Doing so ensures that any changes you make to either of the size values won't distort your
photo.[9] If you want to increase your photo's height without increasing its width (or vice versa), skip this step. 3 Check the "Percentage" box. It's at the top of the window.[10] If you want to resize your image to a specific pixel rating, check the "Pixels" box instead. 4 Change the "Horizontal" value. In the "Horizontal" text box, type in whatever
number you want to use to resize your photo (e.g., to double its size, you would type in 200).[11] If you're using pixels instead of a percentage, you'll type the number of pixels to use into the "Horizontal" text box. If you left the "Maintain aspect ratio" box unchecked, you'll also need to change the "Vertical" text box's value. 5 Skew your photo if you
like. Skewing a photo will angle it to the left or right. To skew your photo, type a number into the "Horizontal" and/or "Vertical" text fields under the "Skew (Degrees)" heading.[12] If you want to skew the photo in the opposite direction, type in a negative value (e.g., "-10" instead of "10"). Advertisement 1 Save changes to an existing Paint project. If
you've already saved your project, you can press Ctrl+S (or click the floppy disk icon in the upper-left corner of the screen) to save the changes. Keep in mind that doing this while editing an existing photo will replace the photo with your edited version. For this reason, it's advisable to create a copy of the photo and edit it rather than editing the
original. 2 Click File. It's in the top-left corner of the Paint window. The menu will appear. 3 Select Save as. This option is in the middle of the menu. Selecting it prompts another menu to appear to its right.[13] 4 Click JPEG picture. It's in the right-hand menu. A "Save As" window will open.[14] You can select any other picture format (e.g., PNG
picture here). 5 Enter a file name. In the "File name" text box, type in whatever you want to name your project. 6 Select a save location. Click a folder on the left side of the window (e.g., Desktop) to select it as the place in which to save your project. 7 Click Save. It's in the bottom-right corner of the window. Doing so will save your file under your
selected name in your specified save location.[15] Advertisement Add New Question Question How do I change the color of an existing line? And if I have a brown line with a black line on top, how do I erase just the brown line? You can change the color of an existing line with the paint bucket tool, which is "fill all." To erase the brown line you can use
the same tool and fill it in white, but you'll have to patch the black line after. Question How do i know that an image is 5x7 so that i can print it? On the Home tab, click "resize," then click the radio button next to "pixels." A 5x7 image is 1500 x 2100 pixels. If your image is not that size, you can resize it by typing those numbers into horizontal (1500)
and vertical (2100) Question How do I write on a picture? Click the text tool (the letter A on the menu), then click somewhere on your picture. Start typing, then click anywhere else on the image when you're finished. See more answers Ask a Question Advertisement Thanks Thanks Thanks Advertisement Thanks Thanks Advertisement Written by:
wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Jack Lloyd. Jack Lloyd is a Technology Writer and Editor for wikiHow. He has over two years of experience writing and editing technology-related articles. He is technology enthusiast and an English teacher. This article has been viewed 514,123 times. Co-authors: 38
Updated: February 24, 2025 Views: 514,123 Categories: Microsoft Paint Print Send fan mail to authors Thanks to all authors for creating a page that has been read 514,123 times. "I work as a property appraiser, and my reports often include graphics such as aerial photographs which need to be enhanced in order to show the location of the subject in
its context. This tutorial really helped me understand my options. Thanks so much!"..." more Share your story By Victor Ashiedu Published March 13, 2021 This Itechguide teaches you different ways to get help with Paint in Windows 10. Learn how to perform different tasks in Paint and Paint 3D - manage canvas, draw, erase, and do more. If you are
entirely new to Paint or Paint 3D in Windows 10, then you will need help with opening the Apps. This section teaches you various ways to open Paint or Paint 3D in Windows 10.Type paint in the Windows 10 search box - the search box is at the bottom left of the taskbar. Then, from the search result, open Paint or 3D Paint. Click the Start Menu. Then,
to open Paint, locate and expand Windows Accessories. Finally, from the Windows Accessories list, click Paint. To open Paint 3D, from the Start Menu, scroll to P (The Start Menu is arranged in alphabetical order). Then, click Paint 3D. Still need help with other ways to open Paint in Windows 10? We have one more for you. If you are techi, you will
love this one! You can open Paint from Run. To open Paint from Run command, follow the steps below:Right-click the Start Menu, then click Run.Finally, on the Run command, type mspaint and click OK.Once you are comfortable with opening Paint or Paint 3D, the next important Windows 10 Paint help topic is managing the Paint Canvas. The Canvas
is the portion of Windows 10 Paint or Paint 3D that “holds” your image. See the highlighted portion of the screenshots below. The first screenshot shows the Canvas for Paint - the second screenshot is for Paint 3D. In the following sub-sections, you will learn how to resize Windows 10 Paint and Paint 3D Canvas. You will also learn how to add Rulers,
Gridlines, or Status Bar in Paint. There are multiple places to adjust and manage the size of Canvas in Paint. This section highlights these options. On the top left of Paint, click File. Then, select Properties. Then, when Paint Properties open, change the Canvas Width and Height - and, click OK. To adjust the Canvas to its default size, use the Default
button. You can also adjust the Paint Canvas size from the View tab. To start, click the View Tab. Then, on the View tab, use the Zoom feature to either Zoom in (increase the size of the Canvas) - or use Zoom out to reduce the size of the Canvas. You can also quickly resize the canvas by hovering your mouse on the bottom right of the canvas. When
you hover, your mouse will turn to 2 pointing arrows. When your mouse pointer changes, drag downwards to increase the size of the canvas. Alternatively, to increase the size of the canvas, drag upwards. Most users new to Windows 10 Paint 3D are keen to get help with learning how to resize canvas in this advanced Paint tool. Fortunately, it is
easier than you would imagine!To resize Paint 3D Canvas size, use the + and - signs on the second menu. To increase the Canvas size, click the + sign. However, if you wish to reduce the size of the canvas, click the - sign. There is one more Windows 10 Paint help topic in this section. In this next sub-section, you will learn how to add Rulers,
Gridlines, or Status Bar in Paint.If you need to add Rulers, gridlines, or remove the Status Bar in Microsoft Paint, you can access these features from the View tab. Need help leaning how to draw or erase in Windows 10 Paint or Paint 3D? This section covers these topics. Before you start drawing in Windows 10 Paint, you may need help understanding
the available drawing features. The features you need are highlighted in the screenshot below. Before you start drawing, your first task is to modify the foreground and background colors. The foreground color is highlighted in the screenshot below - deep red. This is the primary color of your drawing. The second screenshot below highlights the
background color - white. To change any of these colors, click on it. Then, from the displayed colors, select your preferred color. After selecting your preferred colors, you may want to change the color of the canvas. To change the color of your canvas: Click on Color 1 or Color 2 to select it. Then, on the Tools section, click on the Color-filler. Next, to
fill the canvas with your foreground color, left-click the canvas. Alternatively, if you want to fill the canvas with the background color, right-click on the canvas. Now, to the Windows 10 Paint help for this section - learning to draw!To draw free-hand, select a foreground color, and click the pencil tool. Then, draw freely within the canvas. To adjust the
line width, before you start drawing, click the Size drop-down and select a desired line width. In the screenshot below, the thicker white line is drawn with the wider size I selected. Finally, to expand your work, click the magnifier tool. Another important Windows 10 help topic is learning how to draw shapes with Microsoft Paint. To draw shapes, click
the shape you want to draw. Then, drag your mouse on the part of the canvas you want to draw the shape. Open Paint 3D, then click New - to open a new document. Alternatively, if you have an existing image, click Open instead. Then, on the top menu of Paint 3D, click the 2D icon. When you click the 2D icon, Line and Curves will be displayed on the
right pane. Click the line shape you want to draw. Then, within the canvas, draw freely. Once you draw your line, Paint 3D will display additional customization options on the right pane (highlighted in the screenshot below). This sub-section of the Windows 10 Paint help guide includes steps to create shapes in Paint 3D. Follow the steps below to
create 2D or 3D shapes:On the top menu, click on the type of shape you want to draw - 2D or 3D. See the highlighted portion of the screenshot below. When you click on the icon, additional options will be displayed on the right pane of Paint 3D. Then, from the displayed options, click on the shape you wish to draw. Finally, to draw the 2D shape, click
your mouse once at the location you want the shape in the canvas. Moreover, to draw 3D shapes in Paint 3D, on the top menu, click the 3D icon. Then, on the right-pane, click on the 3 shape you wish to draw. Finally, click anywhere within the canvas to draw the shape. If you need help with drawing lines and shapes in Windows 10 Paint, you may also
need help erasing drawings. The next 2 sub-sections offer detailed help to erase drawing from Microsoft Paint and Paint 3D. To erase portions of your drawing in Paint, follow the steps below:On the Tools section, click the Rubber tool. Then, run your mouse on the part (s) of the drawing you want to erase. How to Add Texts in Paint and Paint 3DHave
you been trying to figure out how to add text in Paint? Lighten up as this part of our Windows 10 Paint help guide simplifies this topic.This section is divided into 2 sub-sections - the first sub-section covers steps to add texts in Microsoft Paint. Furthermore, the second sub-section covers steps to add texts in Microsoft Paint 3D. How to Add Texts in
Microsoft PaintOn the Tools section, click the Text tool. Then, drag your mouse on the portion of the canvas you want to add some texts. To add a text, within the text tool in the canvas, type as normal. Initially, the text font size may be very small. To increase the font, highlight the whole text (click and drag). Then, click the font size drop-down (mine
is displaying 11 in the screenshot below), and select a bigger font size.You can also change the text color - to do this, select a different color. As you can see in the screenshot below, my text size is now 20 while the color has changed from white to yellow. That is your Windows 10 Paint text help crash course! How to Add Textsin Microsoft Paint 3DOn
the top menu of Paint 3D, click the Text icon. The word “Text” beneath the “T” may be hidden for you. Once you click the Text icon, drag on the portion of the canvas you wish to add a text. After adding your texts, you can adjust its fonts with the font tools on the right pane. 1 - is used to change the font name of the text2 - is for adjusting the text
size3 - Use this to adjust the color4d - Make text bold, italics, or underlined5 - Left, Center, or Right align the textsThis section of our Windows 10 Paint help teaches you different ways to Copy, Cut and Paste in Paint and Paint 3D. There are various copy and paste operations that you can perform in Microsoft Paint. Firstly, you can copy a line or shape
you previously drew in Paint. Then, paste it somewhere else within the canvas. In this example, I want to copy my Oval shape and paste it in another part of the canvas. To begin, click the Select tool drop-down. Then, from the Select drop-down, click the Rectangular selection tool. With the select tool, drag around the object (or part of an object) you
want to copy - the object will now have some dotted rectangular lines around it. Finally, to copy the highlighted object in Paint, right-click it and click Copy. Furthermore, with the copied item on the clipboard, right-click anywhere on the canvas you want to paste the item - and select Paste. Then, drag the newly pasted item to where you want it on
the canvas. You can also copy an image from outside Microsoft Paint and paste the image in Paint. To do this, on the top left of Microsoft Paint, click the Paste drop-down and select Paste from. Finally, on the Paste from dialogue, open the folder with the photo or image you want to paste. Then, select the image and click Open. The image will be
pasted in Paint. Paint 3D offers more advanced copy and paste options. For example, you can right-click an image outside Paint 3D and select Copy. Then, open Paint 3D, right-click anywhere on the canvas and select Paste. Want to open an existing image in Paint or Paint 3D? This section of the Windows 10 Paint help covers how to do that.To Open
an image in Microsoft Paint, on the top left click File. Then, from the available options, click Open. Finally, open the folder with the image, select the image and click Open. You can also open an image in Paint 3D by clicking the Menu - on the top left. Then, from the displayed options, Open is selected by default. On the details pane, click Browse files.
Finally, navigate to the folder with the image you want and open it. This section of the Windows 10 Paint help guide teaches you how to delete images in Paint and Paint 3D. To delete an object or a portion of an object in Microsoft Paint, click the Select Tool drop-down. Then, from the drop-down options, click Rectangular selection. With the
Rectangular selection tool, drag your mouse on the object (or part of the object) you want to delete. The portion of the image you dragged the Selection tool through will have dots around it. To delete, you can press the Delete key on your keyboard. Alternatively, right-click the area and select Delete. That portion of the image will be deleted - see the
second screenshot below. To delete in Paint 3D, click the Text icon on the top menu. Then, drag your mouse through the image or part of it. Finally, press the Delete key on your keyboard. Alternatively, right-click the highlighted area and select Delete. In my writing career, from time to time, the need to merge two pictures in Microsoft Paint has
arisen. Whenever I need to, I use Microsoft Paint to merge photos. In this section of the Windows 10 Paint help guide, I will show you how to merge photos with Microsoft Paint or Paint 3D. To import the first photo to Paint, click the Paste drop-down and select Paste from. Then, select the photo and open it. To create space for the second photo, drag
the first photo to the left or to the right - depending on where you want it to be in the new merged photo. Repeat steps 1 and 2 to import the second photo. Then, drag the second photo to where you want it in the canvas. Finally, you can save the new merged photos (File -> Save). Alternatively, use Ctrl + A to select the photo and copy. Here is my
merged photo below - I simply selected all, copied, and pasted it here! If, on the other hand, you prefer working with Paint 3D, here are the steps to merge photos in Paint 3D:On the top left of Paint 3D, click Menu. Then, from the displayed options, click Insert - locate the photo and insert it into Paint 3D. After inserting the first photo, press Ctrl and
A keys to select it. Then, drag it to the part of the canvas you want it in the merged photo.Repeat steps 1-3 to insert the second photo. Then, drag it to where you want it in the merged photo. Here is my merged photo! We are now in the 9th section of this comprehensive Windows 10 Paint help guide. In this section, we will cover cropping, rotating
and resizing images in Paint and Paint 3D. To crop an image in Microsoft Paint, follow the steps below:Click the Select drop-down. Next, click on your selection tool. In this example, I will use the Rectangular selection tool. With the selection tool selected, click around the image you want to retain. In this example, I want to retain the image on the
right and remove the one on the left. I will drag my mouse around the image on the right. Then, on the Image section of the Microsoft Paint menu, click Crop.My image cropped and now shows just the part I want to retain.Rotating an image is another essential Windows 10 Paint help. Here are the steps to rotate an image in Microsoft Paint:On the
Image section of the Paint menu, click the Rotate drop-down. Then, select the degrees you want to rotate the image by.You can also flip the the image vertical or horizontal. Here is the above image flipped horizontal - effectively changing the position of the 2 people in the image! To resize an image in Microsoft Paint:Click Resize in the Image section
of the Paint menu. Microsoft Paint offers 2 resize options. You can either resize by Percentage (default), or by Pixels. To adjust the size of the image using the Percentage feature, change the Horizontal and Vertical % values. The default is 100. In this example, I want to reduce the image to 50% of its current size. I will change the Horizontal % values
to 50. Because the Maintain aspect ratio checkbox is checked, when I enter 50 in the Horizontal field, 50 will also be displayed in the Vertical field. Finally, to save the new size, click OK As seen in the screenshot below, the image has reduced by 50% on both sides.You can resize any image by any % value.Additionally, you can resize an image using
the Pixels option. To do this, select Pixels in the Resize options screen. Then, enter the new Pixel values and click OK. Compared to Microsoft Paint, it the cropping tool in Paint 3D is more advanced. Here is how to use the cropping tool in Paint 3D:On the top menu of Paint 3D, click Crop. The image will be highlighted and additional cropping options
will be displayed on the right pane. For fast cropping, select one of the predefined options in “Choose your framing” section. You could also click Custom to add a your custom frame. Further down that pane, you may amend the Width and Height of the mage. There is also an option to Lock aspect ratio. Finally, when you finish with selecting your
cropping options, at the bottom of the right pane, click Done. Follow the steps below to rotate or flip an image in Paint 3DOpen the image you want to rotate or flip in Paint 3D. Then, press Ctrl and A keys on your keyboard to select the image. Once the image is selected, additional options will be displayed on the right pane of Paint 3D. At the bottom
of the right pane, use the first 2 icons to rotate the image - and the last 2 to flip. After doing all the hard work in Windows 10 Paint or Paint 3D, you will definitely need help saving it. This section shows you how to save in Microsoft Pain and Paint 3D.There are 2 methods to save your work in Microsoft Paint. You can press the Ctrl and S keyboard
shortcut or use the File menu. When you press Ctrl + S keys, if you are saving the image for the first time, the Save As dialogue will be displayed. However, if you had previously saved the image, when you press Ctrl + S keys, all recent changes will be saved. To access the Save or Save As option via the File menu, click File on the Microsoft Paint
menu. Like in Microsoft Paint, pressing the Ctrl and S keys in Paint 3D opens the Save As dialogue if you are saving the image for the first time. However, if you previously saved the image, pressing Ctrl and S keys saves recent changes.To access the Save As and Save opens without the keyboard shortcut, click Menu. Then, from the displayed options,
select Save or Save As. If you select the SaveA number of Windows 10 users also want to get help with printing in Paint or Paint 3D. This section offers help for this topic. To print an image in Microsoft Paint, you can use the Windows Print shortcut - Ctrl and P keys, pressed simultaneously. However, you may also access the print option from the File
menu. When you hover over Print (via File menu), Microsoft Paint offers 3 options - Print, Page setup, and Print preview. To open the Print dialogue, click Print. However, to adjust the print settings, Page setup. Within Page setup (see the screenshot below), you can adjust the paper size, and change the printer paper Source. Additionally, you can
select whether to print the image in Landscape (default) or Portrait. Finally, you can modify the image print Centering and/or Scaling. Back to the Print options, you can also select Print preview. Like in Microsoft Paint, you can print in Paint 3D by pressing Ctrl and P keys simultaneously. This opens the print dialogue. The Paint Print dialogue box has
all the standard print options. You can change the image print orientation and Paper Size.The Print dialogue box also offers other options Scaling, Alignment and number of copies. When you are ready to print, on the bottom left, click Print. This is yet another Windows 10 Paint help topic - sending an image via email or setting and image as desktop
background. To set an image as desktop background from Microsoft Paint:Click File and hover over Set as desktop background. Then, select a background option. To send an image via email from Microsoft Paint, click File. Then, select Send in email. Paint will open the image in your default email client. We are now getting to the end of our Windows
10 Paint help guide. This section is a full list of Paint keyboard shortcuts and what they do. S/NKeyboard Keyboard ShortcutWhat the Shortcut Accomplishes1Ctrl and W keysOpens the Resize and Skew settings screen2Ctrl and N keysCloses the current picture and open a new empty canvas3Alt and V keysSwitch to Paint View tab4Alt and H
keysSwitch to Paint Home tab5Ctrl and O keysOpens the Paint “Open” dialogue box - so you can open an existing image in Paint. 6Ctrl and S keysSaves changes made in Microsoft Paint. F12 keyOpens the Save As dialogue7Ctrl and R keysShows or hides Ruler - also accessible via the View menu. 8Ctrl and P keysOpens the Print dialogue box to print
the image in Paint9Ctrl and G keysAdds or removes the Gridlines10Alt and F4 keysClose Microsoft Paint11Ctrl and E keysDisplays the Image Properties9Ctrl and Z keysUndo the last action10Ctrl and A keysSelects the entire canvas in Microsoft Paint11Ctrl and C keysCopies a selected areal2Ctrl and V keysPastes the item in the clipboard - Ctrl + V
pastes an item whether it was copied from within Paint or another appAlt and F keysOpens Paint File menul3Ctrl and Page Up keysZoom In. Similar to Ctrl and Mouse scroll up14Ctrl and Page Down keysZoom Out. Similar to Ctrl and Mouse scroll Down15Ctrl and U keysUnderline selected text16Ctrl and B keysBold selected text17Ctrl and I
keysltalicize selected text18F1 key Opens search results for “help with paint in windows 10” in Bing.com19F11 keyView image in Full Screen mode20Esc keyCancel existing selection21Delete keyDelete a selectionl. How do I get Paint back on Windows 10? Microsoft Paint is installed in Windows 10 by default. However, if you search Paint and cannot
find it, follow the steps below to get paint back on Windows 10:1 - Enter manage optional features in Windows 10 search, then, open it from the search result2 - When the Manage Optional features screen opens, click add a feature, search for Microsoft Paint, and install it. 2. What is the shortcut key to open Paint? Microsoft Paint does not have a
short key to open it directly. However, you can open it via the Run command. Here are the steps:1 - Right-click the tart Menu and click Run. 2 - When Run opens, enter MSPaint and click OK.See the screenshots below: 3. What replaced Paint in Windows 10? Windows Paint is not replaced in Windows 10. Windows 10 still has Microsoft Paint installed
by default. However, Windows 10 has an advanced Paint app called Paint 3D. You can use Microsoft Paint or Paint 3D in Windows 10. If for any reason Microsoft Paint is not available in your Windows 10 copy, install it via Manage Optional features. 4. What are the steps to start MS Paint? Follow the steps below to start MS Paint in Windows 10:1 -
Press the Windows logo and R key simultaneously to open Run. 2 - When Paint opens, type MSPaint and click OK. 5. How can we open a saved drawing in Paint? To open a saved drawing in Microsoft Paint, on the top left of Paint, click File. Then, from the displayed options, click Open. Finally, navigate to the folder you saved the drawing, select it and
click OK. The drawing will open in Paint. I hope you found this Windows 10 guide helpful. If you found this guide helpful, kindly spare 2 minutes to share your experience by responding to the “Was this page helpful?” question below.Finally, for more Windows 10 Itechguides, visit our Windows 10 How-To page. Was this page helpful? Yes (17)No (9)
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Respond to "Was this page helpful?" above Leave a comment with the "Leave a Comment" form below Email us at [email protected] or via the Contact Us page. Microsoft Paint is an important application of Windows 11/10 that is used to create or draw different pictures on the Paint canvas. The Paint application offers various tools, different kinds of
brushes, shapes, and a wide palette of colors to draw pictures and to edit them. It also allows you to download a picture from the web and copy it on the Paint canvas or page, and edit it the way you want!How to use Microsoft Paint in Windows 11/10To open the Paint application, click on the START button > Windows Accessories > Paint OR type
Paint in the search box on the Taskbar and then select the Paint application from the results. The following window will open on your screen. This is how the Paint canvas looks like.At the top of the Paint window, you will see the Toolbar, where you can carry out various functions. This toolbar includes the File tab, Home tab, and View tab. Let us now
look into it in detail.1] HomeThe Home tab is the default tab when you open the Paint application. In the Home tab, you can carry out various functions related to the image, clipboard, tools, shapes, and colors.Under Clipboard, you can perform commands such as cut, copy, and paste, where you can cut or copy a selection from the canvas and paste it
on the keyboard. Under the Image section, you can crop, resize, and rotate the picture. You can rotate left and right to 90 degrees, rotate to 180 degrees and flip vertical and horizontal as well.The Tools group will allow you to draw a free-form pencil line with the selected width, add text, pick a color and use it for drawing, fill an area on the canvas
with the selected color, use the magnifier for a particular area on the canvas, and use the eraser to erase a particular area of the picture. Click on the Brushes drop-down menu to draw using different kinds of brushes. You will find a variety of brushes with different effects such as crayon, marker, natural pencil, etc. In the reference picture below, I
have used a few tools to show you how they look and feel.Here, I have used the free-form pencil tool, a few brushes, the shape fill tool, and the text tool. You can also convert your 2D drawing into a 3D picture by editing it in Paint 3D. Go ahead and simply explore! With all these tools, you are sure to make your picture look attractive and simply
awesome!Text ToolsOn your Paint canvas, choose the location where you want to add the text box and type the desired text in it. You can format the text by selecting the font type, font size, changing the font to bold and italics, and underlining or striking through the text. You can choose the desired foreground color as well as the background color.
Refer to the example shown below.Under the Shapes group, you can insert ready shapes such as rectangle, pentagon, diamond, star, callout, and so on. Click on Outline to choose from the various options such as solid color, crayon, marker, oil, natural pencil, watercolor, or even no outline. Click on Shape Fill to select the medium for the fill, such as,
solid color, crayon, marker, oil, natural pencil, watercolor, or no fill. Under the Size drop-down menu, you can select the size or width of a particular tool. You will see four variations under Size such as 1px, 3px, 5px, and 8px. See an example shown below.I have used certain tools such as the text tool, pencil, brushes, and fill with a Color tool to draw
the following picture. Select the shape you want to draw and the size of the width of the tool. Here, I have selected a 3px size for the Lightning shape with a solid outline color like brown and a crayon fill as yellow.The Colors group includes a wide palette of colors that you can choose for your drawing. You can also edit with Paint 3D using advanced
tools, which we will later cover in detail in another post.Read: Microsoft Paint Tips & Tricks.2] ViewThe View tab includes three groups named Zoom, Show or hide, and Display.The Zoom group enables you to zoom in or zoom out into the picture as much as you want for a better viewing experience, or you can also zoom to exact 100%. Under the
Show or hide group, you will find settings related to rulers, gridlines, and status bar. With the help of Rulers, you can view and measure the object or a particular picture on your Paint canvas. Gridlines will help you to align objects in your picture. By checking or unchecking the Status Bar option, you can show or hide it at the bottom of the Paint
window.In the Display group, you can view the picture in Full Screen; and you can show or hide the Thumbnail window.3] FileUnder the File menu, you can open an existing or already created picture, create a new picture, and save the current picture in the desired location. You can import files from a scanner or camera, print a picture, and send a
picture as an attachment in an email message as well. You can change the desktop background by setting the current picture as the desktop background. You can change the Properties of the current picture as well. And finally, you will see the Exit option to close or exit the application.Quick Access ToolbarOn the top left side of the Paint window,
above the Toolbar, you will see the Quick Access Toolbar.Here, you will find the shortcuts to save the current picture, undo or redo the last action, and minimize, maximize, and close the application. You can also customize the quick access toolbar as per your requirements. You will find additional settings here to minimize the ribbon, to show the
quick access toolbar below the ribbon, etc. So, go ahead and customize and make changes to the quick access toolbar as per your requirements. This will make your work much easier and quick.Read: How to create Images using Cocreator in Paint applIn this post, firstly, we have seen the two main ways on how to open and begin the Paint application.
And secondly, we covered all the components of the ribbon and the quick-access toolbar. I hope this post covered all the details on how to use the Paint application and how to create or draw a new picture by using the various Paint tools and accessories.Now read: How to use Paint 3D App in Windows.



